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Micro Focus Enterprise Developer 2.1
Update 1 for Eclipse Release Notes

These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.

Note: This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link. Web
sites by their nature can change very rapidly and although we try to keep our links up-to-date, we
cannot guarantee that they will always work as expected.

Important: Application executables that were compiled using earlier Micro Focus products must be
recompiled from the sources using Enterprise Developer. For more information, read the section
Upgrading to Enterprise Developerfor Eclipse in the product Help.

Enterprise Developer is a contemporary development suite for Eclipse that allows mainframe developers to
maintain, develop and modernize mainframe applications regardless of whether these are to be deployed
back on the mainframe or onto alternative platforms.

Enterprise Developer supports IBM COBOL, IBM CICS, IBM JCL, IBM DB2, IBM z/OS file formats and
common batch utilities including SORT. This means that the core mainframe online and batch applications
can be developed and maintained under Enterprise Developer. These applications can then be deployed
back on the mainframe or migrated onto one of the Micro Focus Linux, UNIX or Windows based production
platforms.

Enterprise Developer comes in three product variants:

Enterprise
Developer
Personal Edition

Enterprise Developer Personal Edition is a free product, available for download. It is
suitable for anyone who wants to become familiar with the Eclipse or Visual Studio
means of editing and compiling mainframe applications under Windows.

Enterprise
Developer

Enterprise Developer is for customers looking to modernize mainframe applications
and move to an alternative platform. This option again uses either the Visual Studio
or Eclipse-based IDE and includes development and test tools for all platforms
currently supported by Micro Focus.

Enterprise
Developer for
IBM zEnterprise

Enterprise Developer for IBM zEnterprise targets customers modernizing applications
for deployment back on the mainframe or any of the z/Enterprise partitions. This
option uses the Visual Studio or Eclipse-based IDE, mainframe integration and
workflow management. It also includes tools to support development and test on z/
Linux and AIX and x86 environments.

In addition, this document contains information on workflow modelling extensions in the section Enterprise
Developer for z/Enterprise workflow modelling expansion.

Note:

If you are currently using the Personal Edition variant and you want to use the full function edition,
please contact your Micro Focus representative and ask for a free trial.

If you are currently using either Personal Edition or the full edition and you want to try Enterprise
Developer for IBM zEnterprise, please contact your Micro Focus representative and ask for a trial.

Installing Enterprise Developer
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System Requirements

Hardware requirements
The disk space requirements for Windows are:

• Approximately 42MB for the Sentinel RMS license server.
• At least 1GB for Enterprise Developer.

Note: This includes the space needed to cache information locally so that you can modify the
installation without the original source media.

The disk space requirements for UNIX/Linux are:

• Between 26 and 35 MB for the Sentinel RMS license server depending on the platform.
• Between 206 and 427 MB for Enterprise Developer depending on the platform.

Important: The UNIX installation requires extra disk space that equals the size of the product you
install.

Operating Systems Supported
Note: You can produce 64-bit and 32-bit applications on 64-bit operating systems.

The supported Windows platforms are:

• Windows 7 32/64-bit
• Windows 8 32/64-bit
• Windows Server 2008 SP2 32/64-bit
• Windows Server 2008 R2 32/64-bit
• Windows Server 2012 32/64-bit

Note: This product can be installed on earlier versions of Windows but it has not been tested on
them.

The supported UNIX and Linux platforms are:

• POWER running AIX 6.1 TL7 SP5/7.1 TL1 SP5 - 32/64-bit
• x86-64 running Red Hat Linux 5.5/5.8/6.3, Oracle Linux 6.3 with Red Hat Kernel compatibility mode,

Oracle Linux 6.3 with Unbreakable Enterprise Kernel - 32/64-bit
• SPARC running Solaris 10 - 32/64-bit
• x86-64 running SuSE SLES 11/11 SP2 - 32/64-bit
• System Z running SuSE SLES 11 SP2 - 32/64-bit
• System Z running Red Hat Linux 6.2/6.3- 32/64-bit
• HP IA 11.31 - 32/64-bit

Software Requirements

Windows

Note: If you use the Micro Focus Web Installer to install this product, it checks your system and
installs the missing prerequisite software.

UNIX/Linux

• Before installing on Red Hat 6.1, you must have the 32-bit operating system libraries installed:
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GNU Standard C++ Library - libstdc++(i686 version)
The object files for development using standard C libraries – glibc-devel (i686 version)

Check the Red Hat Web site for more information.
• To use the Web installer on Red Hat Enterprise Linux 6.1, you must have the following bug fix updates

for Red Hat installed:

glibc-2.12-1.25.el6_1.3.i686.rpm
openldap-2.4.23-15.el6.i686.rpm
nss-pam-ldapd-0.7.5-7.el6.i686.rpm
zlib-1.2.3-25.el6.i686.rpm
nss-3.12.9-9.el6.i686.rpm
nss-util-3.12.9-1.el6.i686.rpm
cyrus-sasl-lib-2.1.23-8.el6.i686.rpm

You do not need these updates if you use the full product setup file to install the product.

• You need to install Xterm, the terminal emulator for the X Window System. Xterm is part of your Linux/
UNIX distribution but is not installed by default. Use your Linux/UNIX installation media to install it.

• Set the JAVA_HOME environment variable. When installing the product, set this variable to a 32-bit
Java installation or the installation terminates. For example, execute the following:

JAVA_HOME=java_install_dir

where java_install_dir is the path to the JAVA installation directory such as /usr/java/javan.n
• Add $JAVA_HOME/bin to your system PATH variable. To do this, execute:

export PATH=$JAVA_HOME/bin:$PATH

• Set the LANG environment variable to pick up localized messages. The LANG settings are English and
Japanese only.

Other Requirements

Important: This release requires version 10000.2.990 or later of the Micro Focus licensing software.
For local servers, you do not need to install it separately, as the setup file installs a new Enterprise
Developer client and a new licensing server on the same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus Licensing System Administration tool. To check the version of the license server on UNIX,
run /var/microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com/websync/SLM.aspx.

Installing Enterprise Developer for Eclipse

Installation restrictions and requirements
Before starting the installation on Windows, you should consider the following:

• Enterprise Developer and Enterprise Server cannot coexist on the same machine.
• Visual COBOL and Enterprise Developer cannot coexist on the same machine.
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Downloading the Product
1. Use the download links in your Electronic Product Delivery email.

For more information follow the links for the installation instructions and the End User License
Agreement.

Installing
To use the Web Installer:

1. Double-click the enterprisedevelopereclipse21_update1_webinstaller.exe file.
2. Click Start in the Installer window and follow the instructions to install the prerequisite software and the

product.

Alternatively, you can use the setup file on your machine and install the product as follows:

1. Run the enterprisedevelopereclipse21_update1.exe file and follow the wizard instructions to
complete the installation.

A full version of Eclipse, with the Micro Focus plugins already installed, will be present in the C:\Users
\Public\Micro Focus\Product Name\eclipse directory.

Note:

• If you are installing onto a machine that has an existing Micro Focus product that uses an older
Sentinel RMS License Manager, you might be prompted to remove it and install the Micro Focus
License Manager. By doing this you maintain the existing Sentinel RMS license files while adding
the Micro Focus License Manager. If you are unsure about existing licenses on your computer or
removing the Sentinel RMS License Manager, consult your System Administrator. If you want to
proceed, remove Sentinel RMS License Manager by using Windows Add or Remove Programs
and rerun the installation file.

• Trial licenses cannot be used with remote desktop services. If you want to use your product in this
way, please contact Micro Focus SupportLine to obtain a relevant license.

• We recommend that you install any updates for the .NET Framework that are available at the 
Microsoft Download site.

• If you install JDK you might be prompted to install the latest update. The latest update is not
required for use with Enterprise Developer but you can install it if you wish.

Installing Silently on Windows
You can install Micro Focus products silently by using command line parameters to specify the installation
directory, user information, and which features to install.

To install silently use the following command:

start /wait install-file.exe /q [parameters]

where install-file for the following products is as follows:

Enterprise Developer enterprisedevelopereclipse21_update1.exe

The installation file includes a number of individual .msi files, where each .msi file installs one software
component. For instance, enterprisedevelopereclipse21_update1.exe includes one .msi file to
install Enterprise Developer and another to install License Manager; running
enterprisedevelopereclipse21_update1.exe installs both Enterprise Developer and License
Manager.

You can specify different parameters for the different .msi files within the same .exe file by using the /
componentargs parameter. Valid values for the /componentargs parameter are as follows:
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• License Manager
• Enterprise Developer

The examples show how to use the /componentargs parameter.

After the installation is complete you can install the license silently. You need to have your Authorization
Code. To install the license execute:

For 32-bit Windows environments:

start /wait "" <install-dir>\WinNT\cesadmintool –term activate 
AuthorizationCode

For 64-bit Windows environments:

start /wait "" "C:\Program Files (x86)\Common Files\SafeNet Sentinel\Sentinel 
RMS License Manager\WinNT\cesadmintool" -term activate AuthorizationCode

Directory Considerations

• You must have read and write access for every directory accessed during the install.
• You can override the default installation folder using the INSTALLDIR parameter:
• If a path in a definition contains spaces, then the path must be preceded by a backslash and double

quotation mark (\"). For example:

INSTALLDIR=path
INSTALLDIR=\"c:\MyProduct\" 
INSTALLDIR=\"c:\Program Files\Micro Focus\My Product\"

• Installing creates a log file in %temp%\LogFilename by default. To change the location or name, use
the /l parameter on your Setup command line and specify the path and file name, for example:

/l*v drive:\path\LogFilename

The default names for the log files are as follows:

EnterpriseDeveloper_install_log.txt for the Enterprise Developer wrapper

EnterpriseDeveloperx??
_install_log.txt

for Enterprise Developer, where ?? is "86" for 32-bit
systems and "64" for 64-bit systems

lmsetup_install_log.txt for License Manager

• The log filename and folder name cannot contain spaces
• The log file folder must exist before beginning the silent install

Examples

• To silently install Enterprise Developer into a directory other than the default:

start /wait enterprisedevelopereclipse21_update1.exe /q /componentargs
"Enterprise Developer:INSTALLDIR=c:\DirectoryName"

Installing into different Eclipse packages
Micro Focus Enterprise Developer uses Eclipse 3.7. If you want to use Enterprise Developer in other
Eclipse packages based on version 3.7, you must also install the Enterprise Developer update site, and the
RSE and AspectJ plugins. Follow the procedure below to do this.

Important: We recommend you back up all existing Eclipse configuration files first.

1. Install Enterprise Developer as directed above.
2. Copy the required Enterprise Developer resources to your existing Eclipse as follows:

For Windows environments
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1. Extract the contents of the following .zip files in %ProgramFiles(x86)%\Micro Focus
\Enterprise Developer\eclipse\installer to a temporary folder:

• ajdt_2.1.3_for_eclipse_3.7.zip

• RSE-runtime-3.3.zip

2. Copy the extracted folders to <your existing Eclipse>\eclipse\dropins.
3. Copy %ProgramFiles(x86)%\Micro Focus\Enterprise DeveloperEDUpdateSite to

<your existing Eclipse>\eclipse\dropins.
4. Rename each of the folders:

• From ajdt_2.1.3_for_eclipse_3.7 to AJDTUpdateSite
• From RSE-runtime-3.3 to RSEUpdateSite
• From EDUpdateSite to COBOLUpdateSite

5. Move the the contents of the <your existing Eclipse>\eclipse\dropins
\RSEUpdateSite\eclipse folder up a level (that is, to <your existing Eclipse>\eclipse
\dropins\RSEUpdateSite) and delete the empty folder.

6. Copy the eclipse.ini file in %ProgramFiles(x86)%\Micro Focus\Enterprise
Developer\eclipse\installer to <your existing Eclipse>\eclipse, overwriting the
existing file.

3. Restart Eclipse.

Installing Micro Focus Enterprise Developer UNIX Components

Downloading the Product

1. Use the download links in your Electronic Product Delivery email.

For more information follow the links for the installation instructions and the End User License
Agreement.

Installing

Note:

During the installation process, the installer configures the product's Enterprise Server System
Administrator Process User ID. The Process User ID will be the owner of all Enterprise Server
processes except the one for the Micro Focus Directory Server (MFDS). The Directory Server
process (Enterprise Server Administration) runs as root as this allows it to access the system files and
ports.

All enterprise server processes you start from Enterprise Server Administration run under the Process
User ID which can affects the file access and creation.

By default, the installer uses the login id of the user that runs the installer for the Process User ID. To
change the user id after you complete the installation, execute $COBDIR/bin/casperm.sh.

To use the Web Installer:

1. Give the Web installer file execute permissions as follows:

chmod +x webinstaller_entdev_2.1_update1_platform

2. Run the installer from the Process User ID login:

./webinstaller_entdev_2.1_update1_platform

When the installer starts it will prompt you to enter the superuser password so it can perform operations
that require root permissions.

3. If necessary, execute the $COBDIR/bin/casperm.sh script to configure the Enterprise Server
permissions and settings.

Alternatively, you can use the setup file and install the product as follows:
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1. Give execute permissions to the setup file:

chmod +x setup_entdev_2.1_update1_platform

2. Run the installer from the Process User ID login:

./setup_entdev_2.1_update1_platform

When the installer starts it will prompt you to enter the superuser password so it can perform operations
that require root permissions.

The COBOL environment is installed by default into /opt/microfocus/EnterpriseDeveloper.

To install in a different location use the -installlocation="Location" parameter to specify an
alternative directory location. For example:

./webinstaller_entdev_2.1_update1_platform -installlocation="full path of 
new location" 

or

./setup_entdev_2.1_update1_platform -installlocation="full path of new 
location"

You can see details about which additional parameters can be passed to the install script if you enter
the -help option.

You can use the following options to configure the Enterprise Server installation: [ -
ESsysLog="location" ] [ -ESadminID="User ID" ] [ -CASrtDir="location" ],
where:

-ESsysLog Specifies a location in which the build will create the Enterprise Server System log file -
for example, -ESsysLog="/home/esuser/logs". The default location is /var/
mfcobol/logs.

-ESadminID Sets the Enterprise Server System Administrator Process User ID from the command
line - for example, -EDadminID="esadm". The default user ID is the one that runs the
installer.

-CASrtDir Specifies the location were the Enterprise Server run-time system files are placed - for
example, -CASrtDir="/home/esuser/casrt/es". The default location is /var/
mfcobol/es.

Note:

• The installation of this product could affect the SafeNet Sentinel licensed components running
on your machine. During installation licensing is shutdown to allow files to be updated. To
ensure the processes running on your machine are not affected, you need to use the –
skipsafenet option, which skips the installation of SafeNet:

./setup_entdev_2.1_update1_platform -skipsafenet

• To protect the SafeNet Sentinel installation from accidental updating you can create an empty
file named SKIP_SAFENET_INSTALL in /var/microfocuslicensing/ as follows:

touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL

While the file is present, the SafeNet installer does not make changes to the installation or
shutdown the running license daemons. If later licensing needs to be updated, remove the file
and install Sentinel RMS server manually.

Set up the environment

When you have installed the product, you need to set the environment as described below.

1. To set up your product, execute:

/opt/microfocus/EnterpriseDeveloper/bin/cobsetenv
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2. To verify that your product is installed, execute:

cob -Version

Important: These commands set the environment only for the current shell. You need to execute
them for each new shell that you start.

To avoid having to run cobsetenv for every shell, add these commands to the shell initialization files
(etc/profile, etc/bashrc, etc.)

Note that cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

UNIX Installer Issues

License Infrastructure Installer

On some Solaris platforms, you can receive the following error message when SafeNet license server
needs to be installed or upgraded on your machine:

tar: /safenet.tar: No such file or directory

To resolve this issue, wait for the installation to complete and then perform the following:

1. Navigate to the safenet directory in the COBDIR location.
2. With superuser permissions execute: ./MFLicenseServerInstall.sh

License Server

On UNIX, you need to configure the computer hostname to ensure the license server will start properly.

To avoid performance issues, "localhost" and the computer hostname must not both be mapped to IP
address 127.0.0.1. You should only map "localhost" to IP address 127.0.0.1.

The following is an example of how to specify these entries correctly in the etc/hosts file:

127.0.0.1 localhost.localdomain localhost
IP machinelonghostname machineshorthostname

where IP is the unique IP address of the computer in xx.xx.xx.xx format.

Configuring the Remote System Explorer Support

The remote development support from the Eclipse IDE relies upon Enterprise Developer running on the
UNIX machine and handling all requests from the IDE for building and debugging programs. Enterprise
Developer provides a UNIX daemon, the Remote Development Option (RDO) daemon, which initiates the
RDO as Eclipse clients connect to it. Whichever environment is used to start the RDO daemon will be
inherited for all servers and hence all build and debug sessions.

Starting the Daemon

Important: Before starting the daemon you must have the following on your UNIX machine:

• a version of Perl
• a version of Java
• the as (assembler) and ld (linking) programs on the path, as specified by the PATH environment

variable

To start the daemon on the default port (4075) as a background process, perform this command with
superuser authority:

$COBDIR/remotedev/startrdodaemon

The daemon will now listen for any Eclipse client processes connecting to that machine on port 4075. If
you want to use another port, then specify another port number on the startrdodaemon command.
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The daemon can also be configured to instantiate the servers on a specified port or range of ports. This is
particularly relevant when you want to only open certain ports through a firewall. To do this, perform this
command with superuser authority:

$COBDIR/remotedev/startrdodaemon [<port> | <low port>-<high port>] 

where:

• <port> is the port number the daemon should use to listen for connections from Eclipse on the client
machine. If no value is given, it will be assigned a default value of 4075. This value matches the value
assigned within the Eclipse installation.

For example,

$COBDIR/remotedev/startrdodaemon 4999

This command will start a daemon listening on port 4999 and will use random server ports.
• <low port>-<high port> is the range of ports on which the servers (launched by the daemon) should use

to communicate with Eclipse on the client machine.

For example,

$COBDIR/remotedev/startrdodaemon 4080 4090-4999

This command will start a daemon listening on port 4080 and server ports will be in the range 4090 to
4999.

Stopping the Daemon

To stop the daemon, type the following command (with superuser authority):

$COBDIR/remotedev/stoprdodaemon <port>

Configuring the Environment

You may need to configure some aspects of the environment before you start the daemon. This is because
when a build or debug session is initiated from one of the Eclipse clients, the environment used will be
inherited from whatever was used to start the daemon. A typical example of the kind of environment that
might need to be set up would include database locations and settings for SQL access at build/run time.

Repairing

If a file in the installation of the product becomes corrupt, or is missing, we recommend to reinstall the
product.

Installing Mainframe Access Server

Introduction

The installation process for Mainframe Access Server uses a single FTP operation to transfer all of the
mainframe software into a partitioned data set that you pre-allocate. When this transfer is complete, the
remaining installation activities are all done on the mainframe. You customize and submit the pre-built
FRESTORE job to restore the product data sets from the uploaded files and then continue with
customization steps to create an operational Mainframe Access Server.

Requirements

• IBM TCP/IP 4.0, or Interlink TCP/IP 3.1 or higher
• two APPLIDs, two TCP/IP ports
• APF security authorization support personnel availability
• Access to a network share with acceptable space for source and data, as well as the ability to access

the IP address and ports used to access MFA
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• The following installation-specific variable information:

Variable Description

drive

userid TSO user-ID for FTP to your mainframe

pswd TSO password for the FTP user-ID

your.mainframe.name TCP/IP host name or IP address of your mainframe

prodhlq A NEW high level qualifier that will be assigned for all
Host Connectivity data sets when the new Mainframe
Access product is installed. These are NOT existing
product data sets, but rather brand new files that you
will be creating for this base version.

Important: The installation of a new version creates new product run-time data sets before the
upgrade is applied. Any existing Host Connectivity 3.01 libraries remain intact, and can be used for
fallback. If you prefer to retain your former production library names and re-use your existing
prodhlq then rename your old libraries beforehand.

Make a note of the maintenance level of your current Mainframe Access Server. Messages
MFM0001I and MFM0014I on the syslog and XDBOUT sysout data set show the maintenance
level at startup. You may need to know what level you are upgrading from when you complete
post-installation customizations for this upgrade.

Install Mainframe Access Server

In the instructions that follow, the information that you must provide is shown as one of the variable names
from the table of information in the previous section. For example, if your high-level qualifier (prodhlq) value
is MY.MFA, then substitute MY.MFA for prodhlq.

Follow these steps to load Mainframe Access Server:

1. Download the installation file from the link in your Electronic Product Delivery email and extract its
contents to a directory on the PC.

2. On the mainframe, allocate a new partitioned data set named prodhlq.UPLOAD to receive the uploaded
files. Use the following data set characteristics for this upload library:

DSORG=PO                   <=== PDS (partitioned data set)
RECFM=FB                   <=== record format fixed and blocked
LRECL=80                   <=== 80 character record size
BLKSIZE=3120               <=== 3120 character block size
SPACE=(3120,(3500,500,50)) <=== allocate blocks (BLKS) size 3120
                                3500 primary blocks
                                500 secondary blocks
                                50 directory blocks

3. On the PC, issue the following FTP commands. The actual text of the FTP prompts and responses that
you see may differ slightly from those shown in this example.

a. Start FTP:

C:\>ftpyour.mainframe.name
Connected to your.mainframe.name.
220-FTPD1 IBM FTP CS/390 VxRy at YOUR.MAINFRAME.NAME, hh:mm:ss
220 Connection will close if idle for more than 5 minutes.
User (your.mainframe.name:(none)): userid
331 Send password please.
Password: pswd
230 userid is logged on. Working directory is "userid.".
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b. Change the working directory on the mainframe to be the upload library that you allocated:

ftp> cd 'prodhlq.UPLOAD'
250 The working directory "hlq.UPLOAD" is a partitioned data set.

c. Set file transfer type to binary:

ftp> binary
200 Representation type is Image

d. Set FTP prompting off to transfer all files without interruption:

ftp> prompt
Interactive mode Off.

e. Transfer all files from the extracted \Upload directory to members in the prodhlq.UPLOAD library:

ftp> mputdrive:\upload\f*
200 Port request OK.
125 Storing data set prodhlq.UPLOAD(Fxxxxxxx)
250 Transfer completed successfully.        
ftp: xxxx bytes sent in x.xx seconds (xxx.xx Kbytes/sec)
.
.
.

f. When mput has transferred all files the ftp> prompt appears. End the FTP connection:

ftp> quit
221 Quit command received. Goodbye.        

g. On the mainframe, verify that all files transferred successfully and that for each Fxxxxxxx file in the
\Upload directory there is a corresponding member in the prodhlq.UPLOAD data set. There should
be 10 members, F1 through to F9 and FRESTORE.

4. On the mainframe, edit member FRESTORE in the upload library, prodhlq.UPLOAD. Follow the
instructions in that member to customize the JCL and then submit that job to restore the product
libraries from the uploaded files and populate your new product runtime libraries.

5. Start Mainframe Access Server.

After installation

Since the program libraries can change between versions, it is necessary to either create new procedures,
or back up the old procedures, and at least modify the DSNQUAL=prodhlq within your MFA sample started
task procedures as provided by Micro Focus. The prodhlq.LOADLIB and prodhlq.SASC.LINKLIB must both
be authorized.

Verify successful maintenance application by checking the Mainframe Access Server startup message:

MFM0001I: Mainframe Access V4.00 (BASE ) is active

The "(BASE )" indicates the product maintenance level. Also check for "V4.00" in the Mainframe Access
Data Connect server startup message:

MFA303I MFA/DATACONNECT V4.00 - BASE COPYRIGHT (C) 1987-2012 MICRO FOCUS...

When you are satisfied with the new version installation you may delete the UPLOAD data set from your
system.

New parameters and members in the CNTL samples data set

The following updated members are found in the CNTL data set.

MFA sample MFA started task

MFAS *new* sample MFAS started task for Data Connect

MFAAS sample MFAAS application server started task

MFAVTAM sample MFA VTAM definitions

PARMS sample PARMS for MFA started task
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PARMSAS sample PARMSAS for MFAAS started task

SERVERS sample SERVERS configuration for MFA

UPQUICK configuration notes

If you are migrating from Host Connectivity 3.01 WebSync 10 or earlier, you may want to retain your
existing CNTL members from your current version as an installation test. You can simply copy the existing
MFA started task JCL and change the STEPLIB to reference the new product libraries. You will however
be required to modify the MFAS started task JCL since the module names for Data Connect have been
changed to allow co-residence within the same authorized library as MFA.

Review the Change Log in each of the new members. Read the documentation for any new parameters in
the Readme and in the updated Mainframe Access Administrator's Guide. Add these new parameters and
other changes to your working copies. If necessary, customize the new parameters for your installation.

Once you are satisfied with the operation of Mainframe Access, you can consolidate the configuration
settings into the new high-level qualified CNTL members.

Installing the mainframe components

Mainframe zServer

The mainframe zServer is a z/OS server that supports the Eclipse mainframe integration, and is provided
with Enterprise Developer for IBM zEnterprise products. zServer needs to be installed before mainframe
access is enabled.

Refer to the document z/Server Installation Guide for instructions on how to install Enterprise Developer's
mainframe components.

To define
default
zServer
connections

Enterprise Developer supports the configuration of default connections. Default
connections can be defined by creating a file called defaultZConnection.ini in the
Eclipse folder of your Enterprise Developer installation.

The contents of this file must follow these syntax rules:

• Every line must contain one attribute or start with # (Comment)
• Every connection must start with >CONNECTION and end with >END_CONNECTION
• Every connection must be defined with following attributes:

NAME The name of the connection (must be unique)

HOST_ADDRESS The physical address of the host (for example 192.168.1.1,
localhost)

PORT The port of the zServer (scheduler)

DESCRIPTION The description of the connection - this can be left blank

A sample file is included in the installation.

When Enterprise Developer successfully parses the defaultZConnection file, it
creates a z/OS connection in the Remote Systems View for every configured default
connection.

Important: Enterprise Developer reads the defaultZConnection file only once
for each workspace. This means that any changes relating to default connections
will not apply to existing workspaces that have already been used.

Assuming you have the appropriate Enterprise Developer for IBM zEnterprise license,
after installing zServer you should verify the connectivity.
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To verify
mainframe
connectivity

1. Start Eclipse.
2. Ensure the Team Developer perspective is loaded. If it is not visible, select Window

> Open Perspective > Other > <Team Developer>.
3. Right-click in the Remote Systems view and select New > Connection.
4. Select "z/OS" from the connection list and click Next.
5. Enter the TCP/IP address or name of your mainframe system and enter a connection

name that will be displayed in the view. Click Next.
6. Enter the correct connection port and the default encoding parameters. Ask your

system administrator if you do not know the correct parameters.
7. Click Finish. The z/OS entry is added to the view.

To verify the
client host
connection

1. Start Eclipse and switch to the Team Developer perspective.
2. Expand the z/OS connection entry in the Remote Systems view. If the z/OS entry is

not shown in this view, verify the client installation process first.
3. Right-click on the MVS entry and verify, or customize, the port number of the zServer

server (the default is 1111).
4. Right-click on the MVS entry and select Connect.
5. Enter your mainframe user ID and password and click OK. After a successful

connection the color of the icons turns green.
6. Right-click again on the MVS entry and select Disconnect to disconnect from the

host system.

Mainframe Access server (MFA)

Mainframe Access is the OS/390 and z/OS server for Micro Focus development environments. It is a
common component providing access to host resources for environments. One installation of Mainframe
Access can support all of these products, providing connectivity to any number of DB2, IMS, and CICS
systems located anywhere in an enterprise. It can also provide access to JES facilities, VSAM data sets,
non-VSAM data sets, and data controlled by external library management products such as Panvalet,
Librarian and Endevor.

Features include:

• The Drag and Drop utility allows you to transfer files using drag and drop methods, between the
mainframe and the PC environments.

• The Remote Job Step Execution (RJSE) facility enables execution of one or more steps of a job on a
remote z/OS host. It automatically uploads and downloads required files as necessary with an end
result the same as when all steps are executed locally.

• Compare and Synchronization Monitor allows you to mirror mainframe data sets against either
workstation directories, or PVCS archives. This mirroring, known as synchronizing, can occur in either
direction, or both directions. Typically, a user would synchronize mainframe partitioned data sets or
source control systems with a workstation directory for download.

• You can use SourceConnect to map a PC drive to a mainframe dataset. You can then access
mainframe files and resources from a PC, or from applications running on a PC.

After Installing
If you have used Eclipse from the same workspace before, the Eclipse perspective settings are not reset
after installating any Micro Focus product. To pick up any new features, you must reset the COBOL
perspective after installation:

1. Make sure you are in the COBOL perspective by clicking Window > Open Perspective > COBOL.
2. Click Window > Reset Perspective.
3. Click OK.
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4. Reapply any customizations.

Installing X Windows on Windows
Some features of Enterprise Developer for Eclipse on Windows require an X Windows installation, hence
Micro Focus ViewNowX is provided with the product. To install, run the file ViewNow_X_Server.exe in
your Enterprise Developer installation. By default this will be in the %ProgramFiles(x86)%\Micro
Focus\Enterprise Developer\ViewNowX folder.

ViewNowX requires that your client machine has Microsoft Visual C++ 2008 SP1 Redistributable Package
(x86) installed. If it is missing from your machine, the ViewNowX installation will offer a link to download the
package.

Repairing
If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
repair on the installation to replace them.

To repair your installation on versions of Windows Vista or later:

1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.

Uninstalling

Windows

To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:

1. Log in with the same user-ID as you used when you installed the product.
2. Click Uninstall a program under Programs in Control Panel.
3. Click View installed updates in the left-hand pane.
4. Select the product and click Remove or Uninstall as appropriate.

When you uninstall, the only files deleted are those that the installation software installed. If the product
directory has not been removed, delete any unwanted files and subdirectories within it using Windows
Explorer.

Important: The installer creates separate installations for Micro Focus Enterprise Developer and
Micro Focus License Manager. Uninstalling only Enterprise Developer does not automatically
uninstall the Micro Focus License Manager or any of the prerequisite software.

To completely remove the product you must uninstall the Micro Focus License Manager as well.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

UNIX

Note: Before you uninstall the product, ensure that the Enterprise Server Regions and the Micro
Focus Directory Service (MFDS) are stopped.

To uninstall this product:

1. Execute as root the Uninstall_EnterpriseDeveloper2.1.sh script in the $COBDIR/bin
directory.

Note: The installer creates separate installations for the product and for Micro Focus License
Manager. Uninstalling the product does not automatically uninstall the Micro Focus License Manager
or the prerequisite software. To completely remove the product you must uninstall the Micro Focus
License Manager as well.
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To uninstall Micro Focus License Manager:

1. Execute as root the UnInstallMFLicenseServer.sh script in the /var/
microfocuslicensing/bin directory.

The script does not remove some of the files as they contain certain system settings or licenses.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

Enterprise Developer Editions and Licenses
Enterprise Developer comes in the following variants:

Enterprise
Developer
Personal Edition

Enterprise Developer Personal Edition is a free product, available for download. It is
suitable for anyone who wants to become familiar with the Eclipse or Visual Studio
means of editing and compiling mainframe applications under Windows.

Enterprise
Developer

Enterprise Developer is for customers looking to modernize mainframe applications
and move to an alternative platform. This option again uses either the Visual Studio
or Eclipse-based IDE and includes development and test tools for all platforms
currently supported by Micro Focus.

Enterprise
Developer for
IBM zEnterprise

Enterprise Developer for IBM zEnterprise targets customers modernizing applications
for deployment back on the mainframe or any of the z/Enterprise partitions. This
option uses the Visual Studio or Eclipse-based IDE, mainframe integration and
workflow management. It also includes tools to support development and test on z/
Linux and AIX and x86 environments.

Both Enterprise Developer for IBM zEnterprise and Enterprise Developer are available for evaluation from
Micro Focus and both have concurrent and named user license options.

You can use Enterprise Developer Personal Edition for a period of 365 days, after which you will not be
able to use it. A trial license of Enterprise Developer lasts for 30 days, after which, if you have not
authorized it with your authorization code, you will return to Personal Edition functionality.

After activation, you can see how many days your trial license has remaining by selecting Help > Micro
Focus > Product Licensing, or by using the Micro Focus Licensing Administration tool.

To manage your product licenses you need to use the Micro Focus Licensing Administration tool. The tool
allows you to authorize, view and revoke licenses. You can set up your license locally or request a license
from, if your site is using one, a central license server.

You can also apply your authorization code directly within the product from the Micro Focus Product
Name Licensing dialog.

For more on the Micro Focus Licensing Administration Tool, see Licensing in the Enterprise Developer
help.

To activate Enterprise Developer Personal Edition
Note: Having activated Enterprise Developer Personal Edition, your use of it is limited to 365 days.
After this period you will need to enter an authorization code in order to continue using it, either for a
30 day trial or full license of Enterprise Developer.

1. Start Enterprise Developer.

If you have not installed a license for Enterprise Developer, starting the IDE for the first time after you
install the product opens the Micro Focus Enterprise Developer Product Licensing dialog box. If you
cancel this dialog box, you can invoke it again from Help > Micro Focus > Product Licensing.
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2. Click I want to activate the free product.
3. Ensure that the email address used to register the product is in the Email address text entry field. If

you haven't registered your email address yet, click registration page and follow the instructions on
that page.

4. Select one of the following options:

Automatic Use this if you have Internet access.

1. Click Finish to activate your copy of Enterprise Developer Personal Edition.

Manual Use this if you are not connected to the Internet.

1. Click Next and then click Send email.

This opens your default mail client and creates a new email filled in with the details to
email to Micro Focus about activating your copy of the free Personal Edition product.
Send the email.

2. If there is no mail client installed on your machine, copy the email address, the subject
and the exact contents from the Email details fields and paste them into an email to
sent to Micro Focus using a mail client of your choice. Do not modify or add to the text.

You will receive a response email with information with details about your authorization
request.

3. Paste the body text of the response email into the text entry field of the Manual
Activation dialog box.

4. Click Finish.

You should receive a message that the activation has been successful.
5. Restart Eclipse to complete the activation process.

To request and activate a 30-days trial license for
Enterprise Developer
1. In the IDE, click Help > Micro Focus > Product Licensing.

This opens the Micro Focus Enterprise Developer Product Licensing dialog box.

This dialog box also opens if you try to use a feature that is only available in Enterprise Developer and
not Enterprise Developer Personal Edition.

2. Type your email address in the Email address text entry field.

You need to use the same email address you used for the registration.
3. Select one of the following options:

Automatic Use this if you have Internet access.

1. Click Finish to activate the trial license for Enterprise Developer.

Important: If, after you click Finish, you click the Cancel button in the progress
dialog box to stop the activation process, the trial license might have registered on
Micro Focus servers but not yet be registered on your machine. If you request a
trial again then you can get a message saying that a trial license has already been
used. If this happens, you should contact a Micro Focus Sales representative to
obtain a new license.

You can do this by sending an email to EDTEBuyNow@microfocus.com, or
selecting Help > Micro Focus > Buy Now and using the contact options in the
dialog box.
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Manual Use this if you are not connected to the Internet.

1. Click Next.
2. Click Send email.

This opens your default mail client and creates a new email filled in with the details to
email to Micro Focus about activating your trial of Enterprise Developer. Send the
email.

3. If there is no mail client installed on your machine, copy the email address, the subject
and the exact contents from the Email details fields and paste them into an email to
send to Micro Focus using a mail client of your choice. Do not modify or add the text.

You will receive a response email with information with details about your authorization
request.

4. Paste the contents of the response email into the text entry field of the Manual
Activation dialog box.

5. Click Finish.

You receive a message that the activation has been successful.
6. Restart Eclipse to complete the activation process.

After activation, you can see how many days your trial license has remaining by selecting Help > Micro
Focus > Product Licensing, or by using the Micro Focus Licensing Administration tool.

To request a 30-days trial license for Enterprise Developer for IBM zEnterprise

Contact your Micro Focus Sales representative to request a 30-day trial license for Enterprise Developer
for IBM zEnterprise.

To buy and activate a full unlimited license
Note: You can only activate a full license from the IDE if you haven't yet activated Personal Edition.
To activate a full version at any other time you must use the Micro Focus Licensing Administration
tool.

For instructions on using the Micro Focus Licensing Administration Tool, see Licensing in the
Enterprise Developer help.

1. In the IDE, click Help > Micro Focus > Product Licensing > Buy Now.

This opens the Micro Focus Buy Now dialog box.
2. Ensure that the email address you used to register the product is in the Email address text entry field.
3. Click Send email.

This opens your default mail client and creates a new email filled in with the details to contact Micro
Focus. Send the email.

If there is no mail client installed on your machine, you will be presented with a template that includes
the email address and subject line for an email to send to Micro Focus using a mail client of your
choice.

You will be contacted by a Micro Focus Sales representative.

Activating the license from the IDE

When you have bought your license you are given an authorization code with which to activate the product.

1. Start Enterprise Developer.

If you have not installed any license for Enterprise Developer, starting the IDE for the first time after you
install the product opens the Micro Focus Enterprise Developer Product Licensing dialog box. If you
cancel this dialog box, you can invoke it again from Help > Micro Focus > Product Licensing.

20 | Micro Focus Enterprise Developer 2.1 Update 1 for Eclipse Release Notes



2. Click I have a full Enterprise Developer license, paste the code in the Enter authorization code
field, and then click Authorize.

3. Click Finish.

You should receive a message that the activation has been successful.
4. Restart Eclipse to complete the activation process.

What's New
The following sections outline the new features that have been added in this release of Enterprise
Developer for Eclipse.

New features in Enterprise Developer 2.1 Update 1
Note: There are differences between the two variants of Enterprise Developer you might have
installed. Enterprise Developer Personal Edition provides a development environment that supports
analysis, editing and syntax checking of COBOL and mainframe programs outside of the mainframe
environment. It does not, however, support off-mainframe debugging, unit testing and building of
projects. To build, debug, and execute the demonstration application, you need Enterprise Developer.

Compiler Directives

You can now set SQL and PL/I-related Compiler directives and their values more easily, using a grid in a
project’s Properties dialog box.

Enterprise Server

The following new features and enhancements are available:

Clustering Enterprise Server Clustering allows the scaling-out of work units, so that an
increased number of operating system images can share the workload, resulting
in high-performance, multi-system data sharing across all platforms.

Historical Statistics
Facility

The Historical Statistics Facility has been extended to include the generation of
JCL file records, increasing the amount of information customers have available
to assist them in monitoring and tuning their Enterprise Server installations.

Recovery of in-doubt
XA transactions

Some events in XA environments can result in ‘in-doubt’ transactions, where all
parts of a composite transaction are not committed through all participating
resource managers. The recovery of such in-doubt transactions is now
supported.

SSL Support for the
CICS Web Interface

Enterprise Server now allows clients and servers to identify themselves through
X.509 certificates and participate in SSL-enabled conversations.

HCO for DB2 LUW

• Support for 64-bit DB2 ECM
• Support for 64-bit compile and runtime
• Support for DB2 10.1
• New DB2 SQL compiler directive option, BGP, to enable background parsing.

Mainframe Compatibility

Enterprise Developer for IBM zEnterprise is compatible with IBM System z9 mainframe hardware and later.
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PL/I Support

This release of Enterprise Developer includes support for developing, compiling and debugging PL/I
applications, including PL/I-specific project types, file categories, and editors.

• Support for executing PL/I programs using IBM MQ Series software
• DEFINE ALIAS support for the Open PL/I Compiler for XML
• Support for TSO/IDCAMS
• Improved PLISRTD performance on UNIX/Linux
• Improved file I/O speed when using the PL/I language to read or write sequential, indexed and relative

record files
• To enable PL/I for CICS, JCL, IMS you only need to set ES_PLI_SUPPORT=Y. You no longer need to

set ES_PL1_MFFH_JCL=Y.
• Support for character picture data types A,X
• Support for %XINCLUDE (macro preprocessor and compiler)
• Support for %OPTION (macro preprocessor)
• Tolerance for source code containing INLINE and ABNORMAL attributes.
• Support for the TINY and HUGE built-in functions
• New PLICTF and PLICTFHX built-in functions
• Support for the PARAMETER attribute
• Support for the NONINIT attribute

Debugging

You can create a breakpoint for any program in the workspace that your application uses by clicking Run >
Add Program Breakpoint, or clicking the  icon in the Breakpoints view, and entering the name of the
file.

Known Issues
Please, refer to the Known Errors and Restrictions topic in the Product Information section of your product
Help.

In addition, please note the following:

CICS An EXEC CICS DELAY statement may, sometimes, produce a difference of one
second.

COBOL
Watchpoints

The debugger ignores a COBOL watchpoint that is hit if there is no statement
following the statement that modifies the data on which that watchpoint is set.

Debugging It is not possible to start core dump debugging. You can receive incorrect error
messages or notifications.

Documentation The installation instructions in the documentation for Enterprise Server for UNIX
include incorrect filenames of the Web installer and setup files,
webinstaller_entdev_server_2.1_platform and
setup_entdev_server_2.1_platform. The file names should be
webinstaller_entdev_server_2.1_update1_platform and
setup_entdev_server_2.1_update1_platform, respectively.

ICETOOL
Emulation

ICETOOL emulation for managed code is not available in this release.

Enterprise
Server

• On versions of Windows Vista and later, Enterprise Server listens only on the IPv4
loopback address (127.0.0.1). As a result, an attempt to connect to localhost with a
TN3270 emulator such as RUMBA may fail. To work around this issue, in your
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emulator's configuration use 127.0.0.1 in preference to localhost or your host
machine's name.

• The Refresh button at the bottom of the ESMAC pages does not work.

JCL VSE When running Enterprise Server applications on HP Itanium in 32-bit mode, if you
receive an error such as "CASCD1057S JES Initiator for Server ... abended by signal
00004", you need to set the environment value COBMAINSTACK to a value greater
than 500000 to increase the default stack size.

Open PL/I Currently, the Open PL/I Codewatch debugger does not run on 64-bit Windows 8.

Wait for
Attachment
Debugging

There is an issue with "Wait for attachment" when you use Enterprise Developer for
Eclipse to debug applications that run on some Linux/Unix platforms. Eclipse connects
to the debugger on the remote machine, but might not attach to the process to debug
the code.

To work around this issue, ensure that on the remote machine the TMPDIR
environment variable is unset or has the same value for both Micro Focus Enterprise
Developer UNIX Components server and for the running process you wish to debug.
The Micro Focus Enterprise Developer UNIX Components server is the server which
you started either directly with the $COBDIR/remotedev/startrdoserver script or
indirectly using the daemon which is started with the $COBDIR/remotedev/
startrdodaemon script.

To check the variable used by the Micro Focus Enterprise Developer UNIX
Components server:

1. Open Remote Systems view in Eclipse on the Windows machine.
2. Right-click the Shells element of the server connection to be tested and click

Launch Shell.
3. In the Remote Shell view, type echo $TMPDIR in the Command field, and press

Enter.

The value of the TMPDIR environment variable is shown - ensure it is the same as
the one used by the process to be debugged.

Note: The value of TMPDIR used by the Development Hub server cannot be
changed in the remote shell and must be set before you start the daemon or
server.

Resolved Issues
The resolved issues that customers have reported are listed in this section. The numbers that follow each
issue are the Reported Problem Incident number followed by the Customer Incident Numbers (in
parentheses). RPIs that have numbers only (and no text) are included to confirm that the RPIs have been
fixed, since no further information is required.

• CAS (COBOL App Server) General
• CAS XA Switch modules
• Compiler
• Data Tools Converter
• Data Tools Vrecgen (Character)
• Documentation
• Eclipse IDE
• File Handling - External File Handler
• File Handling - Sort / JCL Sort
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• JVM - Debugger
• MF Communications Server
• MF Directory Server
• MTO - CICS Emulation
• MTO - CICS ESMAC
• MTO - IMS TM
• MTO - JCL MVS
• MTO - JCL TSO
• MTO - JCL Utils
• MTO - JCL Utils - IDCAMS
• MVS REXX Emulation
• NCG
• Open PL/I CICS Preprocessor
• Open PL/I Compiler
• Open PL/I Debugger
• Open PL/I Macro Preprocessor
• Open PL/I RTS
• Open PL/I SQL Preprocessor
• RTS
• Setup Issues (UNIX)
• SQL: Cobsql
• SQL: OpenESQL
• XML syntax support runtime

CAS (COBOL App Server) General

Back to List

• HSF includes the following enhancements:

- A new record type (JCLF) for JCL files.

- A Job class has been added to the JCL JOBSTART records.

- A condition code has been added to the JCL STEP records.

- Statistics for up to 5 Transient Data Queues per CICS record has been added (same as for exisiting
TSQ stats). The HSF files will now be created with the following header:

#HSFVer=02 Type,PID,Task,Date,Time,Tran/Job,User/DDName/CC,LU/Step,Prog/DSName,Latent/
ReadCount,Resp/WriteCount,API/RewriteCount,SQL/
DeleteCount,IMS,DSType,DSAccessType,File1,Count1,Time1,File2,Count2,Time2,File3,Count3,Time3,
File4,Count4,Time4,File5,Count5,Time5,TS1,Count1,Time1,TS2,Count2,Time2,TS3,Count3,Time3,TS4
,Count4,Time4,TS5,Count5,Time5,TD1,Count1,Time1,TD2,Count2,Time2,TD3,Count3,Time3,TD4,Cou
nt4,Time4,TD5,Count5,Time5

1082755 (2552658)
• Logging has been added for the resource managers to facilitate recovery from failures that leave the

resource managers such as DB2 and MQ with in-doubt transactions. You only need to log if the
resource manager switch modules are configured to respond to xa_recover() calls. Logging may affect
the performance so you can disable it as follows - edit the server from the Enterprise Server
Administration, click the General tab and type the following in the Configuration Information text box:
[ES-Environment] ES_XA_LOG_SUPPRESS=Y

1085539 (2582570)

CAS XA Switch modules

Back to List
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• The SQL Server XA switch module was updated to resolve some issues with verifying the success or a
failure of ODBC API calls which could lead to failures during the commit or rollback operations.

1087383 (2608663)
• The ODBC one-phase commit switch module has been updated so that when you use it within an

online environment (such as CICS or Web Services), and then you perform a COMMIT, any cursors
that are not defined as WITH HOLD are closed. When you use the module within JES-enabled
transactions that use IKJEFT01, all cursors are closed as before.

1087536 (2610091)

Compiler

Back to List

• Specify an environment variable with the USE and DIRECTIVES Compiler directives (e.g.
USE"$myDirs") to locate a directives file.

1086063 (2592063)

Data Tools Converter

Back to List

• The dfconv replacement input and output filenames are no longer truncated to the filename lengths
used within the profile file.

1086569 (2599741)
• DFCONV, the data file convert command line utility, is now available in Enterprise Server.

1087051 (2605033)

Data Tools Vrecgen (Character)

Back to List

• The source files for the VRECGEN and VRECGEN2 utilities are now stored in the .\src folder in the
product installation.

1087209 (2603963)

Documentation

Back to List

• The SSRANGE Compiler directive is provided for emulation of the IBM mainframe compiler of the same
name; because of this, its scope is limited to the syntax permissible in a mainframe dialect.

1087083 (2605408)
• To ensure no loss of functionality when accessing Vision and RM/COBOL data files, you should use the

appropriate IDXFORMAT Compiler directive setting or file handling option, and not use the
CALLFH(ACUFH) Compiler directive. See 'Configuring Access to Vision Files' and 'Configuring Access
to RM/COBOL Data Files' for more information.

593437 ( )
• The documentation has been updated so that the help page more accurately reflects the ESMAC

screen.

1087753 (2611733)
• All COBOL CICS programs that call user exits need to be compiled with the NOAMODE directive.

593780 ( )
• The documentation now clarifies the EZACICM.MOD location.
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1086693 (2599949)
• The documentation now includes information about the -stcpssl cassub option.

1087060 (2605136)
• The product documentation now includes information about the ES_JESYSMSG_OUTPUT

environment variable.

1087004 (2604533)
• The JCL documentation has been updated to include the error messages JCLAM0187I and

JCLAM0188I.

1087072 (2605203)
• The documentation has been updated to provide more information about the MFJAMS LISTCAT

command.

594069 ( )
• The documentation has been updated to remove references to ERRORLEVEL in Unix environments.

1087575 (2610423)
• The casrdtex documentation has been updated to include several more supported parameters.

594324 ( )

Eclipse IDE

Back to List

• Local Enterprise Server regions without secure user credentials are now started with casstart and
stopped with casstop commands.

1087238 (2606835)
• You can now set program breakpoints as follows - click "Add Program Breakpoint" in the Run menu or

on the Breakpoints view toolbar, and enter the program name in the dialog that is displayed.

1087239 (2606838)
• When you download from a mainframe files that use DBCS characters, any shift-out and shift-in control

characters should be kept in the downloaded source code. When entering new DBCS characters in the
COBOL Editor, shift-out and shift-in control characters must be added manually using the following key
combinations: for shift-out press Alt+S, release them and then press O; for shift-in press Alt+S, release
them and then press I. These key combinations can be altered using the Eclipse Preferences dialog
box.

594093 ( )
• When building within Eclipse, the COBCPY environment variable value set before launching Eclipse

was truncated to a maximum of 1024 characters.

1087408 (2608978)
• Eclipse could stop responding or use excessive amounts of memory when large COBOL JVM projects

were opened.

1087777 (2610488)
• Eclipse could stop responding or use excessive amounts of memory when building large projects.

1087748 (2610469)
• A problem with Variables view not allowing you to modify the values of string variables in EBCDIC

projects has been resolved. In addition, the Change Value dialog now displays correctly the values of
the variables in HEX mode.

593497 ( )
• Variables which were only used in preprocessed source lines were marked as not referenced.

1087030 (2603385)
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• Remote ports that were previously set are preserved when a launch configuration is reopened.

1086008 (2594159)

File Handling - External File Handler

Back to List

• EXTFH configuration options specified under the FOLDER tag now work correctly with UNIX files when
they are specified with an absolute path in the SELECT statement of a COBOL program.

1086089 (2594733)
• RMFM record lock timeouts now work correctly on UNIX.

1087015 (2602108)

File Handling - Sort / JCL Sort

Back to List

• A SORT RETURN statement now returns a 9/230 error for the return past EOF.

1087358 (2606867)
• SORT now terminates with return code 16 and throws a 9/013 error when the catalogued input file is

not physically present.

1087529 (2607690)
• SORT now terminates with return code 16 and displays error message "SORT103E Invalid

operator .JOINKEYS." when the JCL contains the JOINKEYS parameter.

1087311 (2607369)

JVM - Debugger

Back to List

• The JVM COBOL Debugger could only locate copybooks that were located in the same directory as the
COBOL program.

1086348 (2597430)

MF Communications Server

Back to List

• Micro Focus Communications Server no longer fails intermittently with a signal or an exception if a
CICS Web Interface listener fails to start because of a port conflict.

594293 ( )

MF Directory Server

Back to List

• Previously, if you used the -x command line option when exporting an Enterprise Server configuration
definition from MFDS in XML format, the MFDS process would terminate.

1087968 (2609146)

MTO - CICS Emulation

Back to List

• Printer documents initiated by the CICS SPOOL commands are now sent directly to the printer and are
no longer delayed.
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1087941 (2613944)
• The documentation now clarifies the usage of DDnames in the SSTM context.

1085948 (2593338)
• If an alternate file is created and the base name for the referencing file is wrong, the user can now

correct the resource definition base name and apply the changes without having to restart the region.

1084651 (2578312)

MTO - CICS ESMAC

Back to List

• The default queue in ESMAC > JES > Spool is now the OUTPUT queue.

588935 ( )

MTO - IMS TM

Back to List

• An EXEC DLI TERM call could result in a storage violation 114 error in COBOLDLI.

594167 ( )
• You now receive warning and error messages in the console log when the IMS Message Queue

approaches an out-of-space condition, and when its free space is exhausted.

1086438 (2594357)
• IMS Connect EBCDIC message data is now supported.

1088027 (2614756)

MTO - JCL MVS

Back to List

• The informational messages JCLAM0187 and JCLAM0188 are no longer issued inappropriately.

1087086 (2605203)

MTO - JCL TSO

Back to List

• The documentation has been updated to clarify the IDCAMS commands available within TSO batch
jobs.

1084163 (2573281)

MTO - JCL Utils

Back to List

• Under increased load conditions, using multiple initiators, a 9/068 error on casspool was sometimes
reported and a job was not run. Improved status checking has been incorporated to remove this
problem.

1086528 (2587849)
• Input files are no longer optional so you can receive errors if you catalog a file without creating the

physical file. To help avoid failures of JES job steps because of a missing input file, you can use one or
both of the following environment variables: 1) MFALLOC_PCFILE=Y - results in the creation of a
catalog file if DSORG=PS is set in the DCB parameters. 2) MFJ_INPUTDS_ERROR=N - results in
IEBDG, IEBGENER and IEBCOMPR utilities to treat missing input files as though they were present but
empty files.

28 | Micro Focus Enterprise Developer 2.1 Update 1 for Eclipse Release Notes



594968 ( )

MTO - JCL Utils - IDCAMS

Back to List

• The IDCAMS REPRO of records into an RRDS file that already contained data was generating a file
write error. This has been corrcted. If the RRDS file contains records and REPLACE has been specified
in the REPRO command then the records will be overwriten. If REPLACE has not been specified then a
DUPLICATE RECORD (JCLAM0236E) error will be generated.

1086780 (2601984)

MVS REXX Emulation

Back to List

• Execs residing in temporary datasets allocated to SYSEXEC or SYSPROC no longer sometimes fail to
load.

1086478 (2579785)
• The bpxwunix() function is now supported by the REXX engine.

1085190 (2584045)

NCG

Back to List

• An error when linking on Solaris Intel 64 bit with the latest versions of Solaris 10 has been fixed.

1086852 (2602536)
• Display statements of the type "display a(1:i*c) at 0101" could cause the generator to fail when in debug

mode.

1088048 (2607368)

Open PL/I CICS Preprocessor

Back to List

• When a nested %INCLUDE is preprocessed by the macro preprocessor, the corresponding %ENDFILE
is now injected into the preprocessor output in the correct column (column 1).

1082294 (2546061)
• Previously on AIX you could not compile/link with the same commands that were present on Windows,

Linux, and SPARC: you had to execute the preprocess/compile steps separate from the link steps and
manually create an appropriate export list and invoke the ld command directly with the appropriate
parameters. We now create an export list if it does not exist and allow you to preprocess/compile/link in
one mfplx command as you can on other platforms.

593676 ( )
• Using -nodebuginfo with the MACRO preprocessor no longer strips off the %IGNORMARGINS;

directive, so when the mfexecpp (CICS) preprocessor processes the source it no longer loses items in
colums 1 and anything past column 72.

1087424 (2609009)
• In some cases, ldpli failed with an unresolved reference due to the absence of the entry point

MFPLICPPN_<program name>.

1087076 (2603565)

Micro Focus Enterprise Developer 2.1 Update 1 for Eclipse Release Notes | 29



Open PL/I Compiler

Back to List

• Any variable declaration with conflicting storage attributes now produces and E-level diagnostic. The
Open PL/I compiler accepts the first storage attribute and ignores any additional storage attributes.

1087130 (2605852)
• A issue with using SUBSTR of a character pictured variable as a pseudo-variable has been resolved.

1086979 (2603607)
• A problem with a function call in the RETURN statement has been fixed.

1087098 (2605508)
• A problem when using the STRING function as a pseudo-variable and the Compiler switch -range has

been fixed.

1086550 (2597682)
• An erroneous diagnostic for fixed decimal variables accepting the specified number of digits has been

fixed.

1086830 (2600689)
• For the Open PL/I Compiler, the implementation limit of 64 for the number of data and format list pairs

in an edit-directed specification has been increased to 256.

1086769 (2600690)
• The Open PL/I Compiler now correctly handles bit variables with DEFINED storage and the POSITION

attribute.

1086738 (2600658)
• The Open PL/I Compilker no longer encounters a problem using a CHAR(*) VAR parameter as the

argument to the MAXLENGTH built-in.

1087241 (2606704)
• A possible memory leak in -opt mode no longer occurs when using character strings in a relational

comparison.

1085402 (2587143)
• Named constants of type BIT with static initializers no longer has a regression issue.

1087296 (2607316)
• When initializing fixed decimal static arrays, an erroneous 343E diagnostic message with regard to

precision and scale was being issued.

1087452 (2609295)
• An issue which resulted in a SIGSEGV during the code generator phase of the Compiler has been

resolved.

1087283 (2607092)

Open PL/I Debugger

Back to List

• The CodeWatch Debugger no longer traps while to evaluate a user function in the debugged procedure
on Windows operating systems with Data Execution Prevention (DEP) turned on.

588762 ( )
• The Open PL/I Debugger no longer traps while to evaluate a user function in the debugged procedure

on Windows operating systems with Data Execution Prevention (DEP) turned on.

579079 ( )
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Open PL/I Macro Preprocessor

Back to List

• When you used the PL/I Macro Language PARMSET() built-in, it would sometimes incorrectly report
PARMSET() as true for an argument that had not been passed in. The problem was most prevalent
when a combination of KEYWORD invocation and positional parameter invocations were intermixed
multiple levels deep.

592695 ( )
• If a PL/I Macro is written so that KEYWORD parameters (as opposed to positional parameters) are

used, and a macro is driven that uses a KEYWORD parameter which is not supplied, the result is no
longer truncated at the location of the missing KEYWORD parameter.

1084556 (2578580)
• The output from "NOTE" in PL/I was being incorrectly written to STDERR instead of STDOUT.

STDERR was then causing a loop when you ran it from within the Visual Studio IDE.

1086977 (2603654)
• The Open PL/I Macro Preprocessor now handles multiple closes of macros.

1084417 (2577063)
• When running the macro preprocessor as part of an Open PL/I Compile, if there are missing

%INCLUDE files, we now flag them as SEVERE errors which are visible in the Visual Studio Output
Tab even with the minimal level of MSBuild information enabled. We terminate after the macro phase,
allowing the customer to correct the situation before continuing.

1084419 (2577072)
• The Open PL/I macro preprocessor now supports the new %XINCLUDE statement.

593874 ( )
• When the macro preprocessor was making multiple passes on the same portion of code, %ENDFILE

and %FILE were not always generated in Column 1. This was causing issues for the CICS and SQL
preprocessors.

1087132 (2605895)

Open PL/I RTS

Back to List

• The performance of the Open PL/I internal subroutine P$ANY2 which handles unoptimized conversions
from one data type to another has been improved and it now runs faster.

1087119 (2605529)
• The correct link level context is now being maintained for writes to SYSPRINT and PLIDUMP from

within PL/I CICS Programs. Also, if DCB attributes are not specified for the PLIDUMP DD in the CICS
SSTM file (or an SSTM file was not used) then the output no longer contains extraneous garbage data
in the TDQ for each record written to the PLIDUMP.

1087347 (2603565)
• The correct LINK level context are now maintained for writes to SYSPRINT and PLIDUMP from within

PL/I CICS Programs.

1087346 (2603565)
• Accessing PL/I Regional(1) files from an Open PL/I Program no longer triggers an ONKEY condition

when attempting to read KEY(0) from an OPEN PL/I Program. This behavior should have returned 'FF'x
if the record was not present or the actual record if present.

1087690 (2611584)
• Reading from a PL/I "Regional(1)" dataset into a "CHAR VARYING" field no longer results in garbled

data being returned from a successful read.
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1087674 (2611386)
• When using a VSAM RRDS to emulate PL/I Regional(1) file, a trap no longer occurs if the RECSZ()

parameters for AVG, MAX used to define the VSAM RRDS are identical.

1087675 (2611383)
• Writing or rewriting to a record contained in an Open PL/I "Regional(1)" file no longer triggers the

ONKEY condition if a key of 0 was used.

1087762 (2612112)
• Studio Enterprise Edition 6.0 SP2 WS1 Hotfix 11 eliminated a memory leak on multiple open/close

cycles. This introduced a new issue, where an OPEN/CLOSE of an initial file followed by two or more
consecutive OPENs of INPUT and OUTPUT types resulted in bogus 9/148 file status and ON ERROR
being triggered. This behavior only occurred if the first file opened was closed prior to the opening of
second and subsequent files.

1086579 (2599958)

Open PL/I SQL Preprocessor

Back to List

• The SQL precompiler was not recognizing the NOT SYMBOL properly which resulted in SQL
precompiler errors.

1087179 (2606194)
• A problem with a sporadic incorrect occurence of Error 2000A has been fixed.

1087150 (2606039)
• The mfdb2 pre-compiler did not tolerate the "BUFFERED" attribute when it was used on a file

declaration.

1086978 (2603472)

RTS

Back to List

• When upgrading mainframe-based PL/I code to Enterprise Server, if the application utilized the
CEE3ABD API then it failed to link with an unresolved external.

1084537 (2578370)

Setup Issues (UNIX)

Back to List

• During installation, the CheckDiskSpace function no longer relies on English text strings from the UNIX
df command.

1086610 (2600117)

SQL: COBSQL

Back to List

• The COBSQL preprocessor could not process options longer than 65 characters.

1085597 (2589416)

SQL: OpenESQL

Back to List
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• The SQL JVM Run-Time .jar library file is now supplied as part of the Micro Focus COBOL deployment
products for UNIX.

1087595 (2610662)
• A DBMAN=OCI option is now available in OpenESQL for PL/I programs. The option enables you to use

Oracle's OCI API rather than ODBC to talk to Oracle databases.

1086487 (2598954)
• The OpenESQL preprocessor sometimes generated incorrect query lengths for EXEC SQL PREPARE

INTO FROM statements, resulting in the SQL queries being truncated.

1087324 (2607761)
• The OpenESQL preprocessor incorrectly rejected certain characters that are valid in PL/I but not in

COBOL.

1086846 (2603129)
• The ODBC pre-compiler now allows you to define host variables after the DECLARE CURSOR SQL

statement if they are not defined in the PROCEDURE DIVISION.

1086501 (2599123)
• When using the SQL Server Native Client ODBC driver, the OpenESQL Run-Time System now

correctly processes SQL Server data defined as VARCHAR(MAX).

1086665 (2601192)

XML syntax support runtime

Back to List

• The XML preprocessor now generates correct output for the COUNT IN clause.

1086285 (2596137)

Updates and SupportLine
Our Web site gives up-to-date details of contact numbers and addresses.

Further Information and Product Support
Additional technical information or advice is available from several sources.

The product support pages contain a considerable amount of additional information, such as:

• The WebSync service, where you can download fixes and documentation updates.
• The Knowledge Base, a large collection of product tips and workarounds.
• Examples and Utilities, including demos and additional product documentation.

To connect, enter http://www.microfocus.com in your browser to go to the Micro Focus home page.

Note: Some information may be available only to customers who have maintenance agreements.

If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web
site, www.microfocus.com. If you obtained the product from another source, such as an authorized
distributor, contact them for help first. If they are unable to help, contact us.

Information We Need
However you contact us, please try to include the information below, if you have it. The more information
you can give, the better Micro Focus SupportLine can help you. But if you don't know all the answers, or
you think some are irrelevant to your problem, please give whatever information you have.
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• The name and version number of all products that you think might be causing a problem.
• Your computer make and model.
• Your operating system version number and details of any networking software you are using.
• The amount of memory in your computer.
• The relevant page reference or section in the documentation.
• Your serial number. To find out these numbers, look in the subject line and body of your Electronic

Product Delivery Notice email that you received from Micro Focus.

On Windows, if you are reporting a protection violation you might be asked to provide a dump ( .dmp) file.
To produce a dump file you use the Unexpected Error dialog box that is displayed when a protection
violation occurs. Unless requested by Micro Focus SupportLine, leave the dump setting as Normal
(recommended), click Dump, then specify a location and name for the dump file. Once the dump file has
been written you can email it to Micro Focus SupportLine.

Alternatively, you might be asked to provide a log file created by the Consolidated Tracing Facility (CTF) -
a tracing infrastructure that enables you to quickly and easily produce diagnostic information detailing the
operation of a number of Micro Focus software components.

On UNIX, you can use the Micro Focus UNIX Support Scan Utility, mfsupport, to create a log file that
contains the details about your environment, product, and settings. The mfsupport script is stored in
$COBDIR/bin.

To run mfsupport:

1. Start a UNIX shell.
2. Set COBDIR to the product with issues.
3. Execute mfsupport from a directory where you have write permissions.

This creates a log file, mfpoll.txt, in that directory.
4. When the script finishes, send the mfpoll.txt file to your Micro Focus SupportLine representative.

Note:

If COBDIR is set to a location that does not contain etc/cobver, the script outputs the contents
of /opt/microfocus/logs/MicroFocusProductRegistry.dat which keeps a list of the
installed Micro Focus products.

If COBDIR is set to a location that does not contain etc/cobver or COBDIR is not set, mfsupport
gives you the option to search your machine for possible product locations. Note that the search can
take some time if you have a large amount of disc storage and files.

Creating Debug Files
If you encounter an error when compiling a program that requires you to contact Micro Focus technical
support, your support representative might request that you provide additional debug files (as well as
source and data files) to help us determine the cause of the problem. If so, they will advise you how to
create them.

Disclaimer
This software is provided "as is" without warranty of any kind. Micro Focus disclaims all warranties, either
express or implied, including the warranties of merchantability and fitness for a particular purpose. In no
event shall Micro Focus or its suppliers be liable for any damages whatsoever including direct, indirect,
incidental, consequential, loss of business profits or special damages, even if Micro Focus or its suppliers
have been advised of the possibility of such damages. Some states do not allow the exclusion or limitation
of liability for consequential or incidental damages so the foregoing limitation may not apply.

Micro Focus is a registered trademark.
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Copyright © Micro Focus 1984-2013. All rights reserved.

This product includes software developed by Computing Services at Carnegie Mellon University (http://
www.cmu.edu/computing/)".

Micro Focus Enterprise Developer 2.1 Update 1 for Eclipse Release Notes | 35


	Contents
	Micro Focus Enterprise Developer 2.1 Update 1 for Eclipse Release Notes
	Installing Enterprise Developer
	System Requirements
	Hardware requirements
	Operating Systems Supported
	Software Requirements

	Installing Enterprise Developer for Eclipse
	Installation restrictions and requirements
	Downloading the Product
	Installing
	Installing Silently on Windows
	Installing into different Eclipse packages
	Installing Micro Focus Enterprise Developer UNIX Components
	Downloading the Product
	Installing
	UNIX Installer Issues
	Configuring the Remote System Explorer Support
	Repairing

	Installing Mainframe Access Server
	Installing the mainframe components
	After Installing
	Installing X Windows on Windows
	Repairing
	Uninstalling


	Enterprise Developer Editions and Licenses
	To activate Enterprise Developer Personal Edition
	To request and activate a 30-days trial license for Enterprise Developer
	To buy and activate a full unlimited license

	What's New
	New features in Enterprise Developer 2.1 Update 1

	Known Issues
	Resolved Issues
	Updates and SupportLine
	Further Information and Product Support
	Information We Need
	Creating Debug Files

	Disclaimer


